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Tutorial 4: Using CHAID with Multiple
Correlated Dependent Variables
Often a segmentation is desired that is predictive of not one but multiple criteria. For example, in database
marketing, dependent variables might include 1) response to the most recent mailing (responder vs.
nonresponder), 2) response to past mailings, 3) the amount spent, 4) profitability, and possibly others.
Magidson and Vermunt (2005) described an extended CHAID algorithm for such situations, which has
been implemented in SI-CHAID 4.0. A copy of that article, entitled An Extension of the CHAID Tree-based
Segmentation Algorithm to Multiple Dependent Variables, is included with the SI-CHAID 4.0 manual, and
may also be obtained from the www.statisticalinnovations.com website.

The Data
(Source: 2000 Pre-Post National Election Studies, U. of Michigan, Center for
Political Studies)
The example in Magidson and Vermunt (2005) utilized several demographic variables as potential
predictors of 10 attributes (dependent variables) plus an 11th dependent variable which measured the
candidate voted for in the 2000 U.S. election. Only respondents who voted for Bush or Gore were included
in the analysis.
For this tutorial, the original file is US2000ELEC.sav. We show how to set up and perform the hybrid
CHAID analysis using the data file US2000electPOST.sav (see Fig. 3) as input. For each case, this file
contains the demographic variables as well as the posterior membership probabilities (clu#1, clu#2, clu#3).
Y1 – Y10: These attributes are measured using a 4-point scale in response to the question “How well does
[attribute] describe [candidate]” -- ‘extremely well’, ‘quite well’, ‘not too well’, ‘not well at all’. For clarity
in interpretation, these response categories were re-coded ‘4’, ‘3’, ‘2’, and ‘1’ respectively, so that higher
scores correspond to more favorable opinions.
The first 5 attribute variables ratings for candidate Gore are:
Y1: MORALG -- Morality
Y2: CARESG -- Caring
Y3: KNOWG -- Knowledgeable
Y4: LEADG -- Strong Leader
Y5: HONESTG -- Honest (reversed from ‘Dishonest’)
For candidate Bush, the corresponding attribute variables are:
Y6: MORALB
Y7: CARESB
Y8: KNOWB
Y9: LEADB
Y10: HONESTB
and
Y11: Vote: Vote for Bush or Gore during the 2000 U.S. Election
The demographics used as CHAID predictors were:
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Z1: EDUC -- education
Z2: OCCUP occupation
Z3: GENDER
Z4: AGER -- recoded age
Z5: EMPSTAT -- employment status
Z6: EDUCR -- education
Z7: MARSTAT -- marital status
The data file showing the first 6 cases is given below:
Figure 48. The Data File US2000ELEC.sav

As shown in the article, the extended CHAID approach resulted in the 6 demographic segments depicted in
the following CHAID Tree Map:
Figure 49: Tree Map for 6 CHAID Segments
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Steps Used to Obtain the CHAID Segments
As indicated in Magidson and Vermunt (2005), the hybrid CHAID algorithm consists of 3 steps. This
tutorial focuses on steps #2 and #3 which involves the use of the SI-CHAID 4.0 program. For this current
example, the 3 steps are:
Step 1: Obtain a proxy for the dependent variables by using Latent GOLD 4.0 to perform a latent class
(LC) analysis based on the responses given to the 11 dependent variables. This step resulted in 3 latent
classes: class 1 (32%) clearly favors Gore – over 99% of this class voted for Gore, class 2 (39%) was
neutral – 50% voted for each candidate, and class 3 (29%) favored Bush – over 98% voted for Bush.
Step 2: Obtain the demographic CHAID segments using the 3-category LC variable as the CHAID
dependent variable. Since this LC variable is a proxy for and is highly predictive of the 11 dependent
variables, demographic segments found by CHAID to be predictive of it, should also be predictive of the 11
dependent variables. To reflect the degree of uncertainty associated with class membership for each
respondent, posterior membership probabilities for belonging to each of the 3 classes is obtained from the
LC model and used directly in the SI-CHAID analysis.

Figure 50: The Data File US2000elecPOST.sav

Note: Latent GOLD tutorial #4 illustrates a hybrid CHAID performed using a CHAID definition (.chd) file
generated directly by Latent GOLD 4.0. The default settings can be used directly to produce a CHAID tree
immediately or the .chd file can be edited using the CHAID Define program prior to growing the tree.
Step 3. Obtain segment-level predictions for each of the 11 dependent variables using the segments
obtained from the hybrid CHAID analysis. The following table summarizes the predictive relationship
between these segments (columns) and the dependent variables (rows). The segments are ordered from high
to low on their percentage who voted for Bush. The p-value column shows that with the single exception of
the Bush ‘Knowledgeable’ attribute, the CHAID segments are found to be statistically significant in
predicting each dependent variable. The ‘Total’ column shows that the highest overall ratings are for Gore
on Knowledgeable and Bush on Honesty. Segments #1 and #2 tend to rate Bush higher than Gore on all
attributes, while the reverse is true for Segments #4, #5 and #6.
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Figure 51: Table Summary
Comparing this result with segmentation trees obtained from separate CHAID analyses for each dependent
variable using the traditional CHAID algorithm, Magidson and Vermunt concluded:
“The results suggest that segments obtained from the hybrid CHAID may fall somewhat short of
predictability of any single dependent variable in comparison to the original algorithm, but makes up for
this by providing a single unique set of segments that are predictive of all the dependent variables”.

Growing the CHAID Tree
SI-CHAID consists of 2 programs, called ‘CHAID Define’ and ‘CHAID Explore’. Typically, the Define
program is used first to set the analysis options and then the Explore command is executed to perform the
CHAID analysis.
Ø

Open the CHAID Define program

From the File Menu
Ø

Select ‘New’
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Figure 52: File New Dialog Box

The Analysis Dialog box opens.
Figure 53: The Analysis Dialog Box

Ø

Select the demographic variables as shown in Figure 53

Ø

Click ‘Predictors ->’

The demographic variables are now included in the SI-CHAID Predictors box
Ø

Select the sampling weight variable SAMPWGT

Ø

Click ‘Weight’ ->
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This variable is now included in the Weight box.

Normally, only a single dependent variable is included in the Dependent box. To specify that the hybrid
algorithm is to be used:
Ø

Click on ‘Dep Prob’ box

A checkmark appears next to this box. SI-CHAID now knows that posterior membership probabilities will
be used to specify the categories of the dependent variable. To specify the dependent variable:

> Select the variables CLU#1 – CLU#3

Your screen should now look like this:

Figure 54: The Analysis Dialog Box after editing

Ø

Click ‘Dependent ->’

The posterior membership probabilities are now moved to the Dependent box.
Ø

Click ‘Scan’
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SI-CHAID scans the data file and guesses as to the predictor scale types, which appear to the right of each
predictor variable name. The scale type ‘Free’ means that CHAID is free to combine any of its categories
that are not significantly different with respect to the dependent variable, while ‘mono’ means that only
adjacent categories may be combined. The ‘float’ scale type setting means that the predictor is treated as
‘mono’ except for the last (‘floating’) category (generally containing missing values) which is ‘free’ to
combine with any category.

To change the setting of MARSTAT to Free:
Ø

Right click on MARSTAT to retrieve the scale-types pop-up menu

Ø

Select ‘Free’

Your screen now looks like this:

Figure 55: Analysis Dialog Box with Scale Types Pop-up Menu

To change some other default options:
Ø

Click ‘Options’

The Options tab opens:
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Ø

Select ‘Auto’ as the Start up Mode

This change allows a tree to be generated automatically with up to 3 levels. Your screen now looks like
this:

Figure 56: Options Tab

Ø

Change Before Merge Subgroup Size and After Merge Subgroup Size to 0

To grow the tree:
Ø

Click ‘Explore’

CHAID prompts you to save the updated definition file named Model1.chd (the default name)
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Figure 57. Save File Dialog Box

You may change the name of this file and the directory where it will be saved
Ø

Change the name to ‘uselect.chd’

Ø

Click Save to save the definition file and open the CHAID Explore program

CHAID Explore opens and displays the resulting segmentation tree.

Figure 58: Segmentation Tree Nodes Showing the % in each Latent Class
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A new feature in SI-CHAID 4.0 is the Save Tree Option.
To save this tree,
Ø
Ø
Ø
Ø

Make sure that the root node is the current (active) node
From the Tree menu, select Save
Specify the file name ‘6demosegs’
Select Save

The tree is saved in the form of a CHAID tree (.ctf) file named ‘6demosegs.ctf’
To display the score code for these 6 segments:

From the Window menu,
Ø

Select ‘New Source’

Figure 59: Source Code View

Step 3: Show how the CHAID Segments Predict the 11 Dependent
Variables
The SPSS syntax code can be used to assign the cases to the appropriate CHAID segments. Once that is
accomplished, a table such as shown in Figure 51 can be produced to see how well the segments predict
each of the original 11 dependent variables.
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Alternatively, we may use SI-CHAID to see how each of the 11 dependent variables is predicted by the 6
demographic segments. In the remainder of this tutorial, we will show how to do this for the dependent
variable VOTE, and for one of the attribute variables.
Ø

Return to the CHAID Define program

To re-open the Analysis Dialog box
Ø

Right click on ‘Model 1’ and select Edit from the pop-up menu or double click on Model 1

Ø

Click to remove the check mark from the ‘Dep Prob’

The posterior probability variables, are returned to the Variable List box

To move ‘VOTE’ to the Dependent Box
Ø

Select ‘Vote’ from the Variable List box

Ø

Click ‘Dependent ->’

Ø

Click ‘Options’

Ø

In the ‘Start Up Mode’, select ‘No Action’

Ø

Click ‘Explore’
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Figure 60. New Options Tab

To the request for a new file name:
Ø

Enter the file name ‘Vote.chd’

Ø

Select ‘Save’

The Explore program opens and displays the root node of the tree.

From the Tree menu:
Ø

Select Restore

Ø

From the list of file names, select the saved tree file ‘6demosegs’

Ø

Select OK

The saved segmentation is retrieved with the % voting for Gore displayed in the tree nodes. To modify
this to display to the % voting for Bush:
Ø

Select Node Items in the View Menu
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Figure 61. Tree Node Display

The Tree Node Display panel appears
Ø

In the Individual Categories box, select Bush and de-select Gore

Ø

Click Close

The tree now displays the % voting for Bush

Figure 62. Previously Saved Tree with % Voting for Bush Displayed in each Node
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A summary table is given by the Gains Chart
Ø

From the Windows menu, select New Gains to open a new gains chart

Ø

Right click on the gains chart to open the Gains Chart control panel

Ø

Select Bush and De-select Gore (the default) and the percent voting for Bush is now displayed as the
‘Score’

Figure 63. Gains Chart Control Box
For example, the Gains Chart in Figure 63 shows that segment 1 represents 25.3% of all respondents, and
31.0% of respondents who voted for Bush. Under the Score column we see that 59.07% of this segment
voted for Bush, as displayed in the tree node. This also matches the corresponding quantity (57.1%) as
reported in the table in Figure 51.
Ø

Return once again to the CHAID Define program

Ø

Change the Dependent variable from VOTE to MORALG

Ø

Right click on ‘MORALG’ and select ‘Ordinal’

To the right of MORALG, ‘Nominal’ changes to ‘ord-fixed’ indicating that the category scores will be used
Ø

Click Scan
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Figure 64. Analysis Dialog Box following a Scan

In the right-most portion of the Dependent box, the number 4 appears, indicating that there are 4 categories
for MORALG.
Ø

Double click in the dependent box to view the category frequencies.

Figure 65. Category Frequencies for MORALG
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Note that CHAID automatically deletes cases that are missing on the dependent variable.
Ø

Click OK

Ø

Click Explore

Ø

In response to the request for a file name enter ‘MoralG’

Ø

Click Save

The Root Node will once again appear.

Figure 66. Root Node

The mean score for Gore on Morality is 2.92.

To restore the previously saved tree file with MORALG as the new dependent variable,
Ø

From the Tree menu, select Restore

Ø

From the list of file names, select the saved tree file ‘6demosegs’

Ø

Click Open
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Figure 67. Previously Saved Tree with Segment Means Displayed at each Node

Note that this matches the row for MORALG in Figure 51.
It may be of interest to compare the mean segment scores with the segment percentages associated with
each category of the MORALG. To compare these side by side, we will open a second tree window, and
change the node contents for this new tree.
Ø

From the Windows menu, select ‘New Tree’

Ø

From the View menu, select ‘Node Items’

Ø

Select ‘Percents’, and de-select ‘Score’
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Figure 68. Tree Node Display
The contents of the tree nodes in the new tree change from the average scores to the category percentages.

Figure 69. The two Trees side-by-side

Thus, for example, we see that the average MORALG score for segment #1 may be obtained from the
percentages in the new tree as follows:
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9.22%(1) + 24.31%(2) + 51.90%(3) + 14.57%(4) = 2.72.

Use of Correlated vs. Uncorrelated Dependent Variables
One should not conclude from the results reported here that the hybrid CHAID algorithm will always yield
good predictions of all the dependent variables. It should be noted that the data analyzed in this tutorial
consists of dependent variables which are moderately correlated with each other. Therefore, the LC model
used to analyze these data yielded CHAID segments that were found to be predictive of all the dependent
variables.
In contrast to this situation, Latent GOLD tutorial #4 addresses the situation where one of the dependent
variables (UNDERSTAND) is not correlated with two other dependent variables. That tutorial illustrates
the use of a different kind of LC model – a model containing 2 discrete latent factors (DFactors) -UNDERSTAND loads on DFactor #2, while some of the other dependent variables (PURPOSE and
ACCURACY) load on DFactor #1. Not surprisingly, different CHAID segmentations are obtained
depending upon how the CHAID dependent variable is defined (i.e., whether it is defined using the latent
classes associated with DFactor 1 or DFactor 2). In this ‘uncorrelated’ setting the CHAID segments that are
predictive of DFactor 2 turn out not at all to be predictive of PURPOSE and ACCURACY.
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